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What is an $SA-1099/1042S
Social Security Benefit
Statement?

What You Should Know

What to Expect

If You Have Moved

For More Information

Block Access to Your
Personal Information

Request an SSA-1099/1042S for Tax Information

You can request a copy of your most recent SSA-1099 or SSA-10428S using the buttons at the
bottom of this page.
An SSA-1099 is mailed to you in January showing the total amount of benefits you received

in the previous year. If you are a nonresident alien who received or repaid Social Security
benefits last year, you will receive an SSA-1042S instead.

If you need a replacement SSA-1099 or SSA-1042S for an earlier tax year, contact us.
You can request an SSA-1099/1042S for yourself or on behalf of a deceased beneficiary if
you are receiving benefits on the same record as the deceased.

Far security reasons, there is a 30 minute time limit to complete each page. We will warn
you when you run out of time. You can get more time to finish.

A copy of your SSA-1099/1042S will arrive in the mail in about 10 days (30 days if you
live outside the United States) If you need it sooner, contact your local Social Security
Office.

The SSA-1099/10428 will be mailed to the address on file at Social Security.

If you have moved, you must report your change of address to us before we can process
your request.

If you recently reported a change of address to SSA, you need to contact us to make your
request.

For mare information on taxation of Social Security Benefits, or to order the publication "Tax
information for Older Americans” (Publication #554), call the IRS at 800-829-3676 or visit the RS
Web site.

Spedial Instructions for People YWho are Blind

If you want to prevent anline and automated telephone access to your personal information, you
can block access to your personal information.

What Do You Want to Do?

Request for Myself

[ Requestfor a Deceased Person ]
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Replace an SSA-1099/1042S

= This Service Is Currently Unavailable

The SSA-1099/1042S for Tax Year 2006 will be mailed by January 31, 2007.
You can request a replacement SSA-1099/10425 for Tax Year 2006 on or after February 1, 2007
If you need a replacement SS5A-1099/1042S for Tax Year 2005 or earlier:

« Callus tol-free at 1-800-772-1213, or our toll-free TTY number, 1-800-325-0778; or

« Visit your local Social Security Office.
« If you live outside the United States, see Service Around the World.
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Legal Acknowledgement

Sacial Security provides this website for your convenience.
Any person who knowingly and willingly makes any representation
1. that is false to obtain information from Social Security records, and/or
2. that is intended to deceive the Social Security Administration as to the true identity of the
individual,
could be punished by a fine or imprisonment, or both.

| have read the above statement and am the individual to whom the SSA-1099/10425 information
applies.
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Public Agreement

Sacial Security provides this website for your convenience.

The Privacy Act Statement Social Security is allowed to collect the facts on this form under Section 205 of the Social Security
Act We need these facts to quickly identify who you are and provide the information you
requested. Giving us these facts is voluntary. However, without them we may not be able to give
you the information that you want. The Social Security Administration will not use the information
for any other purpose. If you want to read more information on this subject, read The Collection and
Use of Information from Your Application.

Paperwork Reduction Act This information collection meets the requirements of 44 U.S.C. § 3507, as amended by section 2
of the Paperwork Reduction Act of 1995. You do not need to answer these questions unless we
display a valid Office of Management and Budget control number. The OMB cantral number for this
form is 0960-0583, expiration date 02/28/2013. We estimate that it will take about 10 minutes to
read the instructions, gather the facts, and answer the questions. You may send comments on our
fime estimate above to: SSA, 1338 Annex Building, Baltimore, MD 21235-0001. Send only
comments on our time estimate to this address, not the completed form.

By using this website, you agree fo its limitations.
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. General Information About You

Why do you need a
replacement $SA-1099/104257

Have you had a change of

address that has not been ~Yes
reported to Social Security? ' No
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. General Information About the Deceased

Why do you need a
replacement $SA-1099/104257

Previous Continue
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sns Please Log In

Please provide the following information to identify yourself. Be sure to type your name as it is
shown on your Social Security Card.

*Denotes required field

*Your Social Security Number: (without dashes or spaces)
Use your own number even if you
are receiving benefits as a spouse,
parent or child under anather
person's number.

*Your Name: -

First, Middle Initial (if any), Last,
Suffix (if any)

Other Last Name (if any):

For example, your name as shown
on a recent letter from Social
Security or your maiden name.

*Your Date of Birth: - - -
Month, Day, Year

Previous Continue
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Please Log In
Please provide the following information to identify yourself. Be sure to type your name as it is
shown on your Social Security Card.

If you are requesting an SSA-1098/10425 for a deceased beneficiary, you must be receiving
benefits as a spouse, parent or child on the same record as the deceased.

*Denotes required field

*Deceased Beneficiary's Social (without dashes or spaces)
Security Number:

Verify who you are

*Your Social Security Number: (without dashes or spaces)
Use your own number even if you
are receiving benefits as a spouse,
parent or child under anather
person's number.

*Your Name:

First, Middle Initial {if any), Last,
Suffix (if any)

Other Last Name (if any):

For example, your name as shown
on a recent letter from Sacial
Security or your maiden name.

*Your Date of Birth: - - .
Month, Day, Year

Previous Continue
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Go back one page

Y Right-click or pull down to show history '\eplace an SSA_1099/1042‘S (Tax Year 2006)
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v Confirmation

Thank you, Roger Field.
What You Should Know We received your request for a copy of an SSA-1099/1042S on November 1, 2007.

« You should receive your replacement SSA-1099/1042S by November 11, 2007 (December
1, 2007 if you live outside the United States).

« It will be mailed to the address Social Security has on file for you.

« If you do not receive it by November 11, 2007 (December 1, 2007 if you live outside the
United States), please call us Monday-Friday 7:00 a m -7-00 p.m. at 1-800-772-1213 or, if
you are deaf or hard of hearing, on our TTY number at 1-800-325-0778.

« If you live outside the United States, see Service Around the World.

Use your browser’s "print” function to print this page for your records.

Does someone else in your
household want to request a i
replacement $SA-1099/10428? ' No

“ves

Privacy Policy | Accessibiity Policy | Internet Security Policy | Site Map | Feedback
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Confirmation

Thank you, Roger Field.

What You Should Know We received your request for a copy of an SSA-1099/1042S for a deceased beneficiary with the
Social Security Mumber 001-01-0001 on November 1, 2007.

« You should receive the replacement SSA-1099/1042S by November 11, 2007 (December
1, 2007 if you live outside the United States).

« lt will be mailed to the address Social Security has on file for you.

« If you do not receive it by November 11, 2007 (December 1, 2007 if you live outside the
United States), please call us Monday-Friday 7:00 a m -7-:00 p.m. at 1-800-772-1213 or, if
you are deaf or hard of hearing, on our TTY number at 1-800-325-0778.

« If you live outside the United States, see Service Around the World.

Use your browser’s "print"” function to print this page for your records.

Does someone else in your
household want to request a _
replacement SSA-1099/104258? " 'No

“Yes

Privacy Policy | Accessibilty Policy | Internet Security Policy | Site Map | Feedback
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Cookies Not Enabled

To get a replacement SSA-1099 or 10425 (for non-citizens/non-residents) online, you must enable
"cookies" on your computer. We use "session cookies" that we store on your computer only during
your visit. The session cookie keeps you from losing information you've entered for a business
transaction with us if, during your visit, you leave our website and return.

Once you tumn off your computer or stop using the Intemet, the cookie is erased.
To enable coakies, follow the instructions below for the browser you're using.
Microsoft Internet Explorer 6.0+

« Select "Internet Options” from the Tools menu.

« Click onthe "Privacy" tab.

« Click the "Default" button (or manually slide the bar down to "Medium") under "Seftings".
s Click "OK".

Microsoft Internet Explorer 5.x

Select "Internet Options" from the Tools menu.

Click on the "Security" tab.

Click the "Custom Level" button.

Scroll down to the "Cookies" section.

Set "Allow cookies that are stored on your computer” to "Enable”.
Set "Allow per-session cookies" to "Enable”.

Click "OK".

Mozilla Firefox (1.0 final release and earlier)

« Go o the "Tools" menu.
« Select "Options".

« Select the "Privacy” icon in the left panel.

« Check the box corresponding to "Allow sites to set cookies".
« Click "OK" to save changes.

Netscape 7.1/Mozilla 5.0

« Select "Preferences” from the Edit menu.

« Click on the arrow next to "Privacy & Security” in the scrolling window o expand.
« Under "Privacy & Security", select "Cookies "

« Select "Enable all cookies".

» Click "OK".

Microsoft Internet Explorer 4.x

« Select "Internet Options” from the View menu.

« Click on the "Advanced" tab.

« Scroll down to find "Cookies" within the "Security" section.
« Select "Always accept cookies".

« Click "OK".

Netscape Communicator 4.x

« Select "Preferences” from the Edit menu.

« Find the "Cookies" section in the "Advanced" category.
« Select "Accept all cookies" (or "Enable all cookies").

s Click "OK".

m
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You tald us you have maoved and have not reported this to us. To report your new address and
request a replacement SSA-1099/1042S at the same time, please call or visit Social Security.

To contact Social Security: « Inthe United States:
o call us at 1-800-772-1213 Monday through Friday between 7 am. and 7 p.m.
o call our toll-free TTY number, 1-800-325-0778, if you are deaf or hard of hearing,
Monday through Friday between 7 am. and 7 p.m., or
o visit your local Social Security Office.

« If you live outside the United States, see Service Around the World.

Close this window to return to the application.
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How to Report a Change of Address and Request a Replacement SSA-

Ll 1099110428

o

You told us you have moved and have not reported this to us. To report your new address and
request a replacement SSA-1099/1042S at the same time, please call or visit Social Security.

To contact Social Security: « Inthe United States:
o call us at 1-800-772-1213 Monday through Friday between 7 am. and 7 p.m.
o call our toll-free TTY number, 1-800-325-0778, if you are deaf or hard of hearing,
Monday through Friday between 7 am.and 7 p.m_, or
o visit your |ocal Social Security Office.

« If you live outside the United States, see Service Around the World.
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s How to Request Your Replacement SSA-1099/1042S

We're sorry you cannot request a replacement SSA-1099/1042S online. You must call or visit us to
request a replacement SSA-1099/1042S.
To contact Social Security: « Inthe United States:
o call us at 1-800-772-1213 Monday through Friday between 7 a.m. and 7 p.m.
o call our toll-free TTY number, 1-800-325-0778, if you are deaf or hard of hearing,
Monday through Friday between 7 a.m. and 7 p.m_, or
o visit your local Social Security Office.

« If you live outside the United States, see Service Around the World.
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Information about Time Limits

Far security reasons, there are time limits for your work on each page.

« You will receive a warning after 25 minutes on a page that will allow you to extend your time.

« After the third waming on a page, you must move to another page or your time will run out
and you will be logged out.

« If you have turned JavaScript off in your browser, you will not receive these warnings. After
spending 30 minutes on a page, you must move on to another page or you will be logged
out.

Do not use the Back button on your browser to move backward.
Do not use the Enter key to move around in the application.

Close this window to return ta the application.
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Is it safe to transmit
information to the Social
Security Administration over
the Internet?

What is encryption?

Why is special software
necessary to access the
Internet application?

Why SSL?

| have the right software and |
am trying to connect during
your posted business hours,
but | still cannot access your
form. Why?
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Internet Security Policy

SSA is taking all reasonable and proper measures, including encryption, to ensure that your
personal information is disclosed only to you. However, the Internet is an open system and there is
no absolute guarantee that others will not intercept the personal information you have entered or
requested and decrypt it. Although this possibility is remote, it does exist.

Encryption means that all information relating to you and your account is scrambled and locked
with a mathematical key during the electronic transfer. Most browsers have an icon such as a key
or a lock to represent an encrypted mode or session. A broken key, open lock, or no lock indicates
that the session or mode is not encrypted.

So that your online request can remain confidential, SSA uses a secunty protocol (method) called
Secure Sockets Layer (SSL) for this application. You must use a Web browser that supports SSL.
Netscape Navigator and Microsoft Internet Explorer are two browsers that support SSL. Using this
security protocol, all information sent between your computer and our server is encrypted before
being sent aver the Internet.

SSL provides a high level of security and is the security protocol supported by more browsers than
any other. It is estimated that about 92% of Web browsers have an SSL browser available for their
use.

We have found that a number of business, government, and educational networks do not have their
firewalls configured to allow passage of secure Web fraffic. Check with your systems administrator
to determine if this is the case at your site. If this is the case, you will not be able to access this
application web site.

Close this window to return to the application.

Replace an SSA-1099/1042S (Taxvear 2006)

Special Instructions for People Who Are Blind

The fallowing instructions are for screen reader users like JAWS and Window-Eyes and Browser
based readers like Home Page Reader.

In order to fill out this application you will be required fo tab to each control and provide the
requested information. Instructional text usually occurs at the beginning of each screen and can
also be accessed by tabbing through the screen. Tab indices have also been added to allow for
tabbing through text. Additionally, consistent headers have been set up to access questions and
examples/instructions more easily. All headers that are at level 3 will have additional help text.
Additionally, the fitles of each page are header level 1, and they will have general help information.

Unless you have turned Javascript off in your browser, you will receive a warning after 25 minutes
and you can extend your time on the page. After the third warning, you must move o another page,
or your time will run out and your work on that page will be lost.

At the end of most screens there is a Continue button to allow the user to go to the next page and a
Previous button to return o the prior page. The hotkey ALT + C is associated with the Continue
button, ALT + P for the Previous button, and ALT + X for the Exit button. Press Alt + C or ALT + P
and then press Enter to move forward or back, or ALT + X to exit.

Close this window to return to the application.



Social Socurity Online Replace an SSA-1099/1042S (raxvear 2006)

www.socialsecurity.gov

. The Information You Entered Does Not Match Our Records

Please check this information: « If you typed the wrong information, you will need to correct it before continuing.
« If the information is correct, contact Social Security. Be sure to tell the representative that you
tried to complete your request online and received this message.

To contact Social Security:

Call our toll-free number, 1-800-772-1213. Explain that you are unable to complete your
request online. If you are deaf or hard of hearing, call our toll-free TTY number, 1-800-325-
0778 Representatives are available Monday through Friday from7 am to 7 pm.

Go to your local Social Security Office and tell the representative that you were unable to
complete your request.

If you live outside the United States, see Service Around the World.
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This Service Is Not Available at this Time

This service is available during the following hours (Eastern time):

Monday through Friday: 5:00 AM - 1:00 AM
Saturday: 5:00 AM - 11:00 PM

Sunday: 8:00 AM - 10:00 PM

Holidays: 5:00 AM - 11:.00 PM
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e This Service Will Shut Down Within 30 Minutes

The replacement 1099/1042S senvice is available during the following hours (Eastern Time):
Monday through Friday: 5:00 AM - 1:00 AM

Saturday: 5:00 AM - 11:00 PM

Sunday: 8:00 AM - 10:00 PM

Holidays: 5:00 AM - 11:00 PM

Select Continue to start your request now. If the system shuts down before you finish it, you will
have to begin again when the system becomes available.

Select Exit to go to the Social Security home page.

Msg030

Social Socurity Online Replace an SSA-1099/1042S (Taxvear 2006)

www.socialsecurity.gov

. We Are Processing Your Request...

Please wait a moment before selecting the Continue button.
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To resolve the discrepancy:
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sms: You Have Reached the Limit on the Number of Requests

We have not been able to match the information you entered with our records.

« Call our toll-free number, 1-800-772-1213. If you are deaf or hard of hearing, call our toll-free
TTY number, 1-800-325-0778. Representatives are available Monday through Friday from 7
a.m.to7 p.m.

« Call or visit your local Social Security Office.
« If you live outside the United States, see Service Around the World.

Replace an SSA-1099/1042S (Taxeéar 2006)

. Your Session Has Expired

,

If you would like to make this request online, you may select the Start Over button below. Select
Exit to go to the Social Security home page.

Replace an SSA-1099/1042S (raxvear 2006)

= Unable To Complete Your Request at this Time

We are sorry for the inconvenience, but we cannot process your request at this time.
If you still wish to make your request, you may:

« Try again later, or
« Call orvisit us
o Inthe United States:
= call us at 1-800-772-1213 Monday through Friday between 7 a.m. and 7 p.m.
= call our tollfree TTY number, 1-800-325-0778, if you are deaf or hard of hearing,
Monday through Friday between 7 a.m. and 7 p.m., or
= visit your local Social Security Office.

o If you live outside the United States, see Service Around the World.
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s Unable to Process Your Request

If the information you gave us is correct, we're sorry but this service is not available to you.

If the information you gave us is correct and you are currently receiving benefits, online access to

your account may be blocked. For assistance, please call us at 1-800-772-1213, Monday through
Friday between 7 a.m. and 7 p.m. If you are deaf or hard-of-hearing, call our toll-free TTY number,
1-800-325-0778, Monday through Friday between 7 am. and 7 p.m.

[ Returnto Online Services




